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Digital Documentation (Advanced) 
You have already studied that Word Processing is the process to create, edit, save, and print text documents 
on the computer using a word processor. A word processor is a computer application that is used to 
create, edit, and organize a document. One of the examples of Word Processing applications is LibreOffice 
Write. It is a free and open-source word processing software that is part of the LibreOffice suite. It is a 
powerful alternative to other word processors like Microsoft Word, providing similar functionalities with 
support for various file formats. LibreOffice Writer helps you create different types of neat and attractive 
text documents, such as fax documents, reports, and personal and professional letters.   

Session 1: Opening LibreOffice Writer
Perform the following steps to open the LibreOffice Writer application:

	 1	 Press the Windows key  on the keyboard.

	 2	 Start typing LibreOffice. The LibreOffice icon should appear in the search results, as shown in 
Figure 1:

		

	 Figure 1:  Selecting LibreOffice Application

	 3	 Click the LibreOffice icon to open the application.

	 4	 Search for the Writer Document within the Create shelf in the 
LibreOffice Starter window. It usually resembles a document or a 
page with text. Click on it to open LibreOffice Writer, as shown in 
Figure 2. Alternatively, Type LibreOffice Writer in the start menu to 
directly open the Writer, and double-click the LibreOffice Writer 
icon to open it.

When you open LibreOffice Writer, you’ll typically see several key components on the screen:

  Title bar: Displays the name of the application and the document on which work will be done. 

  	Menu bar: Located at the top of the window, the menu bar contains various menus such as File, 
Edit, View, Insert, Format, and others, providing access to different functions and settings.

  Standard toolbar: Below the menu bar, the standard toolbar includes icons for commonly used 
functions such as Save, Undo, Redo, Print, and more. These icons provide quick access to frequently 
used commands.

Figure 2:  Selecting Writer Document
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  Formatting toolbar: This toolbar allows you to change the formatting of text and paragraphs easily. 
It includes options for font selection, text alignment, bold, italic, underline, bullet points, and 
numbering.

  Ruler: The horizontal and vertical rulers are useful for setting margins, indents, and tab stops. 
The horizontal ruler is located at the top, and the vertical ruler is on the left side of the document 
window.

  Document area: The large central area is where you compose and edit your document. This is 
where you type your text, insert images, tables, charts, and other elements.

  Status bar: At the bottom of the window, the status bar displays information about the current 
page number, word count, language settings, and other document-specific details.

The components of LibreOffice are shown in Figure 3:

Standard 
toolbar

Formatting 
toolbar

Ruler
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Title bar

Menu bar

Document area

                                         Figure 3:  LibreOffice Writer Window

Session 2: Working with Styles in Document
A style is a collection of all formatting information, which you want to save and then apply to the 
document. For example, the following details of the Font are stored as default.

Size – 12

Name – Liberation Serif

Weight – None

Alignment – Left
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Style Categories
Writer provides six Style categories, as shown in Figure 4:

  Paragraphs organize document content, starting and ending with the Enter key. Formatting 
options include tab stops, text alignment, line spacing, borders, and character styles for individual 
formatting within paragraphs.

  Character styling modifies specific words or phrases within paragraphs without affecting the entire 
paragraph. It enables changes such as text color, size, highlighting, and emphasis.

  Frames organize document sections with distinct appearances, containing text, graphics, or lists. 
Frame Styles adjust size, position, borders, and text wrapping around images.

  Pages in Writer documents are formatted 
using Page Styles, which define layout aspects 
such as size, margins, headers, footers, 
footnotes, borders, and backgrounds. Each 
document can employ one or multiple page 
styles, defaulting to the built-in Default style 
if unspecified.

  Lists are styled separately to format 
numbering or bullet points with different 
styles or formats.

  Tables efficiently organize large amounts 
of information. Table Styles format tables 
with borders, text and border colors, text 
alignment, patterns, and text formatting 
within cells.

Applying Styles in Documents
Working with styles streamlines document formatting by allowing the consistent application of predefined 
formatting options. This enhances efficiency, ensuring uniformity in text appearance, headings, and other 
elements across the document. Perform the following steps to apply styles using the Styles dialog box:

	 1	 Open LibreOffice Writer. Open a new or existing document containing some text. Select the text in 
the document to which style operations will be applied.

	 2	 Go to the Menu bar and select 
Styles, or press F11 on your 
keyboard. This will open the 
Styles and Formatting window 
on the right side of the screen.

	 3	 Click on the desired style 
category in the Styles box. 
Double-click on the style that 
you want to apply.

In this case, we have selected 
LibreOffice Writer text, and from 
Paragraph Style, we chose Heading 1 
as shown in Figure 5. 

Figure 4:   Different Styles in LibreOffice Writer
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Figure 5:  Selecting Styles
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The output after applying the styles is shown in Figure 6:

Figure 6:   Displaying Text after Applying Style

Applying Styles Using Fill Format Option
Perform the following steps to apply styles using the Fill Format option:

	 1	 Open LibreOffice Writer. Open a new or existing document containing some text. Select the text in 
the document to which style operations will be applied.

	 2	 Go to the Menu bar and select Styles, or press F11 on your keyboard. In the Styles and Formatting 
window, click on the Fill Format Mode button. This button looks like a paintbrush icon and is 
typically located at the top of the Styles and Formatting window. After entering Fill Format Mode, 
your cursor will change to a paintbrush icon.

	 3	 Click on the style you want to apply from the Styles and Formatting window. Now, click or drag 
over the text or paragraphs in your document where you want to apply the selected style. The style 
will be applied to the selected areas. To exit Fill Format Mode, either press Esc on your keyboard 
or click the Fill Format Mode button again in the Styles and Formatting window.

Creating and Updating New Style from Selection
In LibreOffice Writer, you can create and update styles based on selected text to streamline formatting. 
This ensures a consistent appearance and simplifies style management across your document.

Creating a New Style from Selection
Perform the following steps to create a new style from the 
selection:

	 1	 Open LibreOffice Writer. Highlight the text that you want to 
base your new style on. This text will serve as a reference for 
your new style.

	 2	 Go to the Styles menu in the top menu bar. Click on Styles and 
Formatting or press F11 to open the Styles and Formatting 
window.

	 3	 Click on the Style actions button in the Styles and Formatting 
window, which looks like a Letter A with a star on it 
(  ), and then select New Style from Selection as shown in  
Figure 7.

	 4	 Enter a name for your new style in the Style Name field. In 
this example, we saved the Style as My_Style, as shown in 
Figure 8. Right-click My_Style from the Styles dialog box and 
select Edit Style. Adjust the formatting options (such as font, 

Figure 7:  Selecting New Style from Selection

Figure 8:   Saving a new style as My_Style.
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size, color, paragraph alignment, etc.) according to your 
preferences. These settings will be based on the selected 
text. In this case, we used the Highlighting color as Light 
Teal 2 and the Area color as Light Yellow 2. 

	 5	 Click OK to create the new style. Your new style will now 
be available in the Styles and Formatting window. The 
output of applying the styles is shown in Figure 9.

Updating an Existing Style from Selection
Perform the following steps to update a style using the Styles dialog box:

	 1	 Select the page or paragraph you want to modify.

	 2	 Format the selected portion according to your requirements.

	 3	 Navigate to the Style menu and click the update button.

	 4	 Use the Style Action button to update the selected style.

Creating a Style using the Drag and Drop Method
Perform the following steps to create a new style using the Drag and Drop method:

	 1	 Select the category under which you want to create the new style in the Styles dialog box.

	 2	 Click on the specific style where you want the new style to be created. Highlight the text that you 
want to base your new style on.

	 3	 Drag the formatted text from your document into the Style Menu and save the new style with a new 
name.

In this case, we have selected Strong Emphasis from Character Style. The style is saved as Emphasis_
Style. The output is shown in Figure 10:

Figure 10:  Creating a New Style using Drag and Drop

Load Style from Template or Another Document
Perform the following steps to load style from template or another document

	 1	 Open the Styles dialog box. Click on the style action button and select Load Styles from Template.

	 2	 Select from File and navigate to the document or template containing the styles you want to 
import.

Figure 9:   Output of Applying New Style
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Session 3: Working with Images and Graphical Objects
Working with images and graphical objects in LibreOffice Writer involves inserting, editing, and arranging 
elements such as images, shapes, and diagrams. This enhances document presentation, enabling users 
to create visually appealing and informative content through intuitive tools and formatting options.

Inserting an Image from Various 
Sources
Perform the following steps to insert 
images in the document:

	 1	 Open the document to insert an 
image in LibreOffice Writer.

	 2	 Go to Insert W Image from the 
menu bar.

	 3	 Browse to the image file in the 
Insert Image dialog box, select it, 
and click the Open button to insert 
an image into the document. The 
output of the steps is shown in 
Figure 11.

	 4	 Alternatively, insert an image using the Copy and Paste method by copying the image and then 
pasting it into the desired location of the document.

Modifying, Resizing, Cropping, and Deleting an Image
In LibreOffice Writer, modifying, 
resizing, cropping, and deleting images 
and graphical objects allows users to 
customize document visuals. These 
functions enhance the layout, improve 
design, and ensure graphics fit seamlessly 
within the document’s content and 
structure. Perform the following steps 
to modifying, resizing, cropping, and 
deleting images in the document:

	 1	 Use the image inserted in the 
previous step. Double-click the 
image to open the Image dialog 
box. Access options such as 
Positions and Size, Rotation and 
Crop.

	 2	 Enter the desired dimensions for 
precise resizing. Go to Crop, then 
click the arrows in the Keep scale options. Observe the preview shelf for better accuracy, as shown 
in Figure 12.

Figure 11:  Inserting Image in Document

Figure 12:   Cropping an Image
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	 3	 Click on the image to select it. Press Delete key on the keyboard to delete the image from the 
document.

Working with Drawing Objects
Working with drawing objects in LibreOffice Writer allows 
users to create, modify, and format various graphical 
elements such as shapes, lines, and images. This feature 
enhances document presentation by integrating visual 
components seamlessly with text and other content.

To show the Drawing Toolbar in the Writer window,  
wclick on View W Toolbars W Drawing, as illustrated in 
Figure 13. 

This will open the Drawing Toolbar, depicted in Figure 14, which includes a variety of basic drawing 
objects for creating your desired design.

Figure 14:  Drawing Toolbar

Inserting Drawing Objects in a Document
Perform the following steps to insert drawing objects into a document:

	 1	 Place the cursor in the document where you want the drawing to be placed. Select the tool from 
the Drawing toolbar, as shown in Figure 14. The mouse pointer changes to a drawing-function 
pointer.

	 2	 Move the pointer to the place in the 
document where you want the image to 
appear, and then click-and-drag to create 
the drawing object.

	 3	 Release the mouse button to finish 
drawing. The selected drawing function 
remains active, so you can draw another 
object of the same type.

	 4	 Press the Esc key or click the Select icon 
(the arrow) on the Drawing toolbar to 
cancel the selected drawing function. The 
output of the steps is shown in Figure 15.

Setting or Changing Properties of Drawing Object
Perform the following steps to change the properties of a drawing object:

	 1	 Click on the drawing object in the document. This will open the Drawing Object Properties toolbar 
just below the Standard toolbar, as shown in Figure 16.

	 2	 Click the icon of the property to be modified in the Drawing Object Properties toolbar. In this case, 
we have selected the Fill Color as Light Lime 2, Line Color as Dark Lime 3, and Line Style as Dash 
(Rounded). 

Figure 13:   Enabling Drawing tools

Figure 15:  Inserting Drawing Objects in Document
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		  The output of the above steps is shown in Figure 17.

	 	   
	 Figure 16:   Drawing Object Properties toolbar		    Figure 17:   Displaying Object with Selected Properties	

Resizing and Grouping Drawing Objects
Perform the following steps to resize or group drawing objects:

	 1	 Select the object to be resized. All eight handles on the corners and edges will become visible.

	 2	 Click and drag any handle to resize the object. Use corner handles to maintain the object’s original 
shape or edge handles for non-proportional resizing.

	 3	 Select the first object by clicking on it.

	 4	 Hold the Shift key and continue selecting additional objects to include in the group.

	 5	 Select the group tool from the Drawing Object Properties Toolbar (Figure 16) or select Format W 
Group W Group from the main menu to group the selected objects.

Positioning Image in the Text
Perform the following steps to position the image in the document:

	 1	 Right-click on the image and select Anchor W To Paragraph. 

	 2	 Select Wrap W Optimal to wrap the image in the optimal space of the text. Select Flip W Flip 
Horizontally. 

		  The output of the above steps is shown in Figure 18:

		
	 Figure 18:   Positioning the Image in Text
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Session 4: Creating and Using Templates
Templates are preset layouts for creating professional documents easily. This session covers creating 
templates to include reusable content such as logos, images, and text, streamlining document creation 
by avoiding repetitive formatting. Templates can be used for resumes, reports, and more.

Creating a Document using Predefined Templates
Creating a document using predefined templates streamlines the process by providing a ready-made 
layout. Templates ensure consistency and efficiency, allowing you to easily insert and format content like 
text, images, and graphics. 

Perform the following steps to create a new document using templates:

	 1	 Open LibreOffice Writer. Go to File W New W Templates, as shown in Figure 19. Browse through 
the available templates.

		
	 Figure 19:  Finding Template Option

	 2	 Select a template and right-click the Open button to create a new document based on that template. 
A new Untitled document opens up. In this example, we used the Modern template as shown in 
Figure 20.

		
	 Figure 20:  Selecting Modern Template
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Creating a Template
Creating a template in LibreOffice Writer streamlines 
document creation by allowing you to set up reusable 
layouts, styles, and elements, making it easy to generate 
consistent, professional documents efficiently. You can create 
templates from existing documents or use the built-in wizard 
for efficiency.

Creating a Template from a Document
Perform the following steps for creating a template from a 
document:

	 1	 Open a new document and format it as desired (styles, 
headings, footers, etc.).

	 2	 Go to File W Templates W Save As Template. Name the 
template, choose a category, and select Save, as shown 
in Figure 21.

Creating a Template using Wizard
Perform the following steps to create a template using the Wizard in LibreOffice Writer:

	 1	 Go to File W Wizards W Letter or Fax, or select another available option depending on the type of 
document to create a template for.

	 2	 Select the type of document (e.g., Business Letter, Personal Letter) and right-click on the Next 
button in the dialog box.

	 3	 Select the layout and design for the template. Right-click on the Next button and select the 
elements to include in the template (e.g., header, footer, sender, and recipient information). Review 
the selections and right-click the Finish button.

	 4	 Go to File, then Templates, and then Save As Template. Name the template, choose a category, and 
select Save.

Updating a Document Based on Modified Template
Perform the following steps to update a document based on a modified template:

	 1	 Open an existing document and make any style change.

	 2	 Go to File W Save in the menu bar or press Ctrl + S on the keyboard to save the updates. If the 
document is linked to a template and the template is updated, the document will prompt to update 
styles when opened.

	 3	 Select Update Styles to update the styles based on the new template, if prompted.

Session 5: Working with Table of Contents
In LibreOffice Writer, a Table of Contents (TOC) provides an organized overview of document headings. 
It auto-generates based on the applied styles, making navigation easy. Users can customize its structure, 
format, and update it as content changes, ensuring an accurate reflection of the document’s layout.

Figure 21:  Saving a Newly Created Template
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Creating a Table of Contents
Perform the following steps to create a TOC 
in LibreOffice Writer:

	 1	 Open a new or existing document 
containing rough sections and sub-
sections.

	 2	 Apply heading styles (e.g., Heading 
1, Heading 2, etc.) by selecting them 
from the Styles dialog box as shown in 
Figure 22.

	 3	 Position the cursor in the place where 
the Table of Contents will be displayed. 
Go to Insert W Table of Contents and 
Index W Table of Contents, Index, or 
Bibliography from the menu tab. In 
the dialog box that appears, ensure 
the Type tab is selected.

	 4	 Choose Table of Contents as the type. Select OK button to insert the Table of Contents. The output 
of the document is shown in Figure 23:

		
	 Figure 23:  Table of Content in Document

Customization of Table of Contents
Customizing a TOC in LibreOffice Writer allows users to tailor the appearance and structure of the TOC. 
Options include adjusting formatting styles, changing levels of headings displayed, adding hyperlinks, 
and modifying entries. These customizations ensure that the TOC aligns with specific document 
requirements and enhances readability.

Deleting a Table of Contents
If you need to remove a TOC from your document, follow these steps to delete it without affecting the 
rest of your content:

	 1	 Open LibreOffice Writer and select the document containing the TOC you want to delete.

Figure 22:  Applying Heading Style
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	 2	 Scroll through your document to find the Table of Contents. It is typically located at the beginning 
or in a designated section of the document and then select the TOC by right-clicking on the TOC 
title and dragging the mouse till the end of the TOC.

	 3	 Press the Delete key on your keyboard, or right-click on the TOC and choose Delete from the 
context menu. This action removes the TOC from your document.

	 4	 After deleting the TOC, save your document to ensure the changes are preserved. Right-click on 
File W Save or use the shortcut Ctrl + S on the keyboard.

Refer “Digital Documentation (Advanced)” on pages 81-150 in Information Technology (402) book for Class 10 for more.
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Electronic Spreadsheet (Advanced)
In today’s digital age, counting and calculations are essential, from daily tasks to professional work. 
Spreadsheet software, like LibreOffice Calc, helps manage large datasets efficiently, similar to an 
accountant’s ledger. This supplement explores advanced spreadsheet features, including data analysis, 
automation with macros, linking multiple sheets, collaborative editing, enhancing decision-making, and 
streamlining tasks across shared documents.

Session 1: Opening LibreOffice Calc
To open LibreOffice Calc, start by clicking on the Start Menu (Windows) or Applications Menu (Linux) 
on your computer. Next, type LibreOffice into the search bar to locate the LibreOffice suite. Select Calc 
Spreadsheet from the list of applications. Wait for the program to load, and once it opens, you will see a 
blank spreadsheet ready for use as shown in Figure 1:

Window Control Buttons

Menu Bar

Name Box

Row 
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Status Bar

Navigation 
Buttons and 
Sheet Tabs

Active Cell

Input Line

Formatting 
Toolbar

Standard 
Toolbar

Sidebar

Vertical 
Scrollbar

Cell

Zoom Controls

Horizontal 
Scrollbar

Column 
Headings

Title Bar

Figure 1:  Displaying the LibreOffice Calc Window

The LibreOffice Calc window comprises the following components:

  Title Bar: Displays the name of the currently open workbook.

  Window Control Buttons: Allow you to minimise, maximise/restore and close the LibreOffice Calc 
window.

  Menu Bar: Consists of menus, such as File, Edit, View and Insert.

  Standard Toolbar: Consists of tools for performing basic functions, such as open, save, copy, cut 
and paste.

  Formatting Toolbar: Consists of tools for formatting the text.

  Name Box: Displays the address of the active cell or a range of selected cells.

  Input Line: Contains the content of the selected cell or formula applied on the selected cell.

  Column Headings: Refer to the names of the columns.
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  Row Numbers: Refer to the row numbers.

  Cell: Refers to the area of intersection of a row and a column.

  Active Cell: Refers to the cell that is currently active. It is the cell where the data you enter will be 
placed. You can only enter data in an active cell.

  Vertical Scrollbar: Allows you to move the worksheet in vertical direction (up and down).

  Horizontal Scrollbar: Allows you to move the worksheet in horizontal direction (left and right).

  Navigation Buttons and Sheet Tabs: Allow you to navigate from one worksheet to another in a 
workbook. Sheet tabs display names of the worksheets present in a workbook. You can change the 
default name of a worksheet by double-clicking its sheet tab and typing the desired name in the 
Rename Sheet dialog box.

  Status Bar: Displays information about the current worksheet.

  Zoom Controls: Allow you to zoom in or zoom out the Calc worksheet.

  Sidebar: Contains the icons for displaying various panels, such as Properties, Styles and Formatting, 
Gallery, Navigator and Functions. It is located to the right of the LibreOffice Calc window.

Session 2: Data Analysis
Data analysis in LibreOffice Calc involves organizing, interpreting, and visualizing data using features like 
formulas, functions, and charts. It allows users to efficiently analyze trends, patterns, and insights from 
datasets, aiding in informed decision-making and reporting.

Consolidating Data
Consolidating data in LibreOffice Calc combines data from multiple sheets or ranges into a single 
summary. It simplifies data analysis by aggregating information, offering insights from various sources at 
once. Perform the following steps to consolidate the data in LibreOffice Calc:

	 1	 Ensure that the data to consolidate is organized in separate sheets or files, with the same layout 
(i.e., the same columns in the same order) as shown in Figure 2:

		
	 Figure 2:  Data for Consolidation

	 2	 Open a new sheet by right-clicking the plus sign before Sheet1 (  ) and name it Consolidated 
Sheet by double-clicking the sheet name.

	 3	 Click on the cell where the consolidated data will begin; generally, A1 is chosen. Go to Data W 
Consolidate from the Menu bar.

	 4	 Set up the Consolidation:

		  a.	 Source Data Range

i.	 In the Consolidate dialog box, click on the Add button.

ii.	 Enter the range for the first data set from Sheet1 (e.g., Sheet1.A1:D6), then click Add.

iii.	Repeat this for the ranges in Sheet2 (e.g., Sheet2.A1:D6) and Sheet3 (e.g., Sheet3.A1:D6).

		  b.	 Select the function you want to use to consolidate your data. For this example, use Sum.
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	 5	 Configure Options by checking the Row labels and Column labels boxes for adding labels in the 
Consolidated Data sheet. Click OK button to consolidate the data. The output is shown in Figure 3:

		
	 Figure 3:   Consolidated Data

Creating Subtotals
Perform the following steps to create a subtotal in LibreOffice Calc:

	 1	 Combine all the tables in Sheet1, Sheet2, and Sheet3 together in Sheet1. Select the range of data 
to add subtotals to (e.g., A1:D16). Go to Data W Subtotals in the Menu bar. 

	 2	 Select Department under Group by in the Subtotals dialog box. From Calculate subtotals for, check 
the Salary column. Under Use function, select Sum, as shown in Figure 4:

	
	 Figure 4:  Selecting Options for Creating Subtotal
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	 3	 Check the Insert page breaks between groups box in the Options tab to insert page breaks between 
groups. To attain each subtotal on a new row, check the Pre-sort area according to groups. The 
output is shown in Figure 5:

		
	 Figure 5:  Subtotal Output

Using What-If Scenario 
A What-If scenario is a collection of variables that can be plugged into a spreadsheet’s calculations. Each 
scenario is assigned a unique name, allowing you to create multiple scenarios within the same sheet. 
These scenarios are helpful for exploring and comparing different outcomes based on varying conditions. 
They can be used at the start of a project to optimize results. By adjusting inputs and observing the 
corresponding outputs, you can predict potential outcomes and make informed decisions about the best 
course of action.

Perform the following steps to use What-If scenario:

	 1	 Create the following sheet as shown in Figure 6. Enter the function =ABS(PMT(B3/1200,D2,B2)) for 
calculating EMI, =B4*D2 for calculating Total Amount Paid, and =B5-B2 for Total Interest Paid. 

		
	 Figure 6:   What-If Spreadsheet
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	 2	 Select the cells A2 and C2 using Ctrl + Right-click on these 
cells, as these two are the variables in this situation.

	 3	 Go to Tools W Scenario from the Menu bar. Write the name 
of the scenario as Scenario_1 as shown in Figure 7, and click 
the OK button to add this to the scenario list. Uncheck the 
Copy back check box. Keep the Display border as a default.

	 4	 Modify the values in the scenario to create a new scenario. 
In this example, we modified the value of Loan Amount to 
15000000 and Time Period (months) to 180 in the first case 
and Loan Amount to 35000000 and Time Period (months) 
to 120 in the second case. 

	 5	 Repeat Steps 2 and 3 and change the color to Light Lime 
1 and Light Gold 1 respectively. Name the scenarios 
Scenario_2 and Scanario_3 respectively. 

	 6	 Right-click the down arrow button of the scenario to switch 
from one scenario to another. Select the scenario you want 
to display, as shown in Figure 8.

Using What-If Tools
Perform the following steps to create a formula using the what-if 
analysis tool with one formula and one variable:

	 1.	 Enter the data in the cells as shown in Figure 9, and then 
enter the formula =B4*(B1–B2)–B3 to calculate the result 
in B5 from values in other cells, namely B1, B2, B3, and B4. 
Save the name of the sheet as Sale_Sheet.

	 2	 Select cells from D2 to E11. Go to Data W Multiple 
Operations. Click on cell B5 when the cursor is in the 
Formulas in Multiple Operations dialog box. Click on cell B4 
when the cursor is in the Column input cell, and then click 
the OK button. The output generated is shown in Figure 10:

	
	 Figure 10:  What-If Analysis Tool Output

Using Goal Seek and Solver
Goal Seek and Solver in LibreOffice Calc are powerful tools for finding the input value needed to achieve 
a specific goal (output) in a formula. Goal Seek is useful for single-variable problems, while Solver handles 
more complex, multi-variable scenarios with constraints.

Figure 9:   Sale_Sheet

Figure 7:   Creating a Scenario

Figure 8:   Switching Scenarios

©Copyright 2024 by Dreamtech Press



Information Technology18

Using Goal Seek
Perform the following steps to use Goal Seek tool for analyzing data:

	 1 	 Open a new sheet and enter the following data, as shown in Figure 
11. Use the formula =AVERAGE(B2,B3,B4,B5,B6) for calculating the 
average marks obtained. 

	 2 	 Select cell B7 and then go to Tools W Goal Seek from the Menu bar. 
Enter the target value as 75 and the Variable cell as B5, as this is the 
cell that is to be generated by the system, as shown in Figure 12.

	 3 	 Clicking OK button will trigger an error because LibreOffice Calc 
does not allow the Variable cell to be empty. An error dialog box will 
prompt you to add a 0 value in the Variable cell. Click Yes button, 
then repeat Step 2. LibreOffice Calc will display a dialog box asking 
whether to update the cell with the calculated value. Selecting Yes 
button will replace the original value with the calculated one in the 
sheet, as shown in Figure 13.

Using Solver
Perform the following steps to use Solver for analyzing data:

	 1	 Open a new sheet and enter the data, as shown in Figure 14. Enter 
the formula =B2-SUM(B3:B6) in B7 to calculate the Savings and 
=B2-B7 to calculate the Total Expenses. 

	 2	 Select Tools W Solver from the Menu bar. In the Solver dialog box, 
select the desired cell for the Target cell text box to specify the 
goal. In this case, we have selected cell B7 as we need to change our 
savings. In the Optimize result to option, select Maximum. In the By 
changing cells text box, select cell B8, as we need to minimize the 
total expense.

	 3	 Enter the Cell reference and the values in the Limiting Conditions 
section, as shown in Figure 15. Right-click the Solve button in the 
Solver dialog box. 

	 4	 Verify the output provided by LibreOffice Calc. If it’s correct, then 
click the Keep Result button in the Solving Result dialog box. Otherwise, click Restore Previous and 
repeat Step 3 again. The output of the Solver tools is shown in Figure 16.

	 	
	 Figure 15:  Limiting Constraints	 Figure 16:  Solver Output

Session 3: Linking Data and Spreadsheets
Linking data and spreadsheets in LibreOffice Calc allows you to connect and update data across multiple 
sheets or external sources. This feature ensures data consistency and automates updates when source 

Figure 14:  Solver Data

Figure 11:  Goal Seek Data

Figure 12: � Entering Goal Seek 
Variables

Figure 13:  Goal Seek Output
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data changes. It’s useful for managing complex datasets, consolidating reports, or referencing data from 
different sheets without manual copying, enhancing efficiency and accuracy.

Setting up Multiple Sheets
Perform the following steps for setting up multiple 
sheets in LibreOffice Calc:

	 1.	 Click the ‘+’ icon next to the existing sheet tabs 
at the bottom of the window to add a new sheet, 
as discussed in the previous session. Alternatively, 
go to Sheets W Insert Sheet. 

	 2.	 Select the After Current sheet option in the 
Position shelf and change the number in No. 
of sheets in the Sheet shelf in the Insert Sheet 
dialog box, as shown in Figure 17.

	 3.	 Click on the sheet tabs at the bottom to switch 
between sheets. You can also use the keyboard 
shortcuts Ctrl+Page Up to move to the previous 
sheet and Ctrl+Page Down to move to the next 
sheet.

Creating References Between Sheets
Creating references between sheets in LibreOffice Calc allows you to link data across multiple sheets, 
making it easier to manage complex datasets. By referencing cells from other sheets, you can consolidate, 
compare, or calculate data seamlessly.

Referencing a Cell in Another Sheet
Perform the following steps to reference a cell in another sheet:

	 1	 Open an existing worksheet that contains data, and then create a new sheet. Click a cell in the new 
sheet to enter the reference. In this case, we opened our previous existing sheet named 
Demonstration.ods, where we did our demonstrations as mentioned 
in Session 2.

	 2	 Enter the sheet number and the cell number of the sheet where 
we created Subtotals. In this example, enter the following formula 
=Sheet5.B2. The output is shown in Figure 18.

Creating References from Other Documents
Perform the following steps to reference a cell from another document:

	 1	 Create a new spreadsheet by selecting File W New W Speadsheet or by pressing Ctrl + N button in 
Keyboard. Make sure that both spreadsheets are open. 

	 2	 Enter the required information in the spreadsheet. Click the cell where you want to create the 
reference. Type = to start a formula. 

	 3	 Go to Window W Demonstration.ods – LibreOffice Calc. Select the 
relevant cell in the Demonstration spreadsheet and return to new 
spreadsheet. Press the Enter key in the keyboard. The referenced 
cell will show the exact value, as shown in Figure 19. Fill the 
remaining cells by yourself.

Figure 17:   Insert Sheet Dialog Box

Figure 18:  � Referencing Data 
from Another Sheet

Figure 19:  � Referencing Cell from 
Another Document
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Using Hyperlink in LibreOffice Calc
A hyperlink in LibreOffice Calc is a clickable link that navigates to a web page, another sheet, a specific cell, 
or an external document. It’s useful for quickly accessing related resources or data within a spreadsheet.

Hyperlinking External Sheet
Perform the following steps for hyperlinking external sheet:

	 1	 Open a new sheet. Select the cell where the 
hyperlink will be created. Go to Insert W  Hyperlink 
from the Menu bar. A dialog box named Hyperlink 
opens.

	 2	 Select Document on the left side of the Hyperlink 
dialog box. In the Path field, click the folder icon 
and navigate to the external sheet (Demonstration.
ods). Under Target in Document, click the button 
next to Target and choose the specific sheet 
(Sheet1) and cell in the external file as shown in 
Figure 20. 

	 3	 Click Apply button in the Target in the Document 
dialog box, then click Close button. The Sheet1 will appear in the Target textbox. Click Apply  W  
Close in the Hyperlink dialog box to insert the hyperlink in the new sheet. Click on the hyperlink in 
your Calc sheet to open the external document at the specified location.

Hyperlinking Registered Data Sources
Perform the following steps for hyperlinking external sheet:

	 1	 Go to Tools  W  Options  W  LibreOffice Base  W  Databases. Click New button to register a data 
source (e.g., an existing database or spreadsheet).

	 2	 Select the cell where you want to insert the hyperlink. Go to Insert  W  Hyperlink.

	 3	 Choose Internet on the left panel and select Database. In the URL field, enter the registered data 
source URL (e.g., sdbc:embedded:hsqldb:dataSourceName). Optionally, set the table or query 
within the data source that you want the hyperlink to access.

	 4	 Click Apply  W  Close to create the hyperlink. Clicking on the hyperlink will open the registered 
data source, allowing you to interact with the specified table or query.

Session 4: Sharing and Reviewing Spreadsheet
LibreOffice Calc provides the facility of sharing a spreadsheet at a location on a network from where 
multiple users can work on the spreadsheet at the same time. Sometimes, many people review the 
spreadsheet before it is marked as final or submitted for printing. While reviewing the spreadsheet, every 
reviewer can give their suggestions in the form of comments or can directly change the content. After 
reviewing the document, a final draft of the spreadsheet is prepared, incorporating all the suggestions 
and changes in it, if there are any.

Setting Up a Spreadsheet for Sharing
Perform the following steps for setting up a spreadsheet for sharing:

	 1	 Open the spreadsheet that needs to be shared. Go to Tools W Share Document.

Figure 20:  Steps for Hyperlinking External Sheet
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	 2	 Check the box labeled Share this spreadsheet with other users in the Share Document dialog box. 
Then, click OK button.

Opening and Saving a Shared Spreadsheet
Perform the following steps for opening and saving a shared spreadsheet:

	 1	 Open LibreOffice Calc. Go to File W Open and select the shared spreadsheet file.

	 2	 Save the spreadsheet by clicking File W Save or using the shortcut Ctrl+S using the keyboard. If 
there are conflicting changes, LibreOffice Calc will prompt you to resolve them.

Adding, Editing, and Formatting Comments
Perform the following steps for adding, editing, and formatting comments:

	 1	 Select the cell where the comment will be added. Right-click and choose Insert Comment. Enter the 
comment text and click outside the comment box to save it.

	 2	 Right-click the cell with the comment. Choose Edit Comment. Modify the comment text and click 
outside the comment box to save changes.

	 3	 Select the text to format, while editing a comment. Use the formatting toolbar to apply formatting 
(e.g., bold, italics, font size).

Reviewing Changes – View, Accept, or Reject Changes
Perform the following steps for reviewing changes – view, accept or rejects changes:

	 1	 Go to Edit W Track Changes W Show to see all tracked changes.

	 2	 Go to Edit W Track Changes W Manage Changes. In the Manage Changes dialog box, review each 
change. Use the Accept or Reject buttons to accept or reject the changes.

Session 5: Using Macros In Spreadsheet
A macro can be defined as a set of commands or actions that are recorded and then executed in a 
spreadsheet when required. Macro provides the facility to reuse the recorded action in a spreadsheet 
several times when required, thereby making your work easier. By using macros, you can reduce the 
wastage of time in performing repeated tasks.

Record a Macro in LibreOffice
Perform the following steps to record a macro in LibreOffice Calc:

	 1	 Select Tools W Macros W Record Macro to begin recording. A small dialog box with a Stop 
Recording button will appear, indicating that the macro recording is active. Make sure to enable 
macro recording under Optional Features. By default, this feature is turned off in LibreOffice Calc.

	 2	 Enter the desired text that you want the macro to execute. For instance, type your name.

	 3	 Click the Stop Recording button in the small dialog box. This will open the Basic Macros dialog box. 
Open the library container, My Macros.

	 4	 Locate the library named Standard within My Macros. Note that each library container includes a 
Standard library.

	 5	 Select the Standard library and choose an existing module to save the macro. Alternatively, you can 
create a new module by clicking New Module.

	 6	 In the Macro Name text box at the top left section of the dialog box, enter a name for the macro, 
such as EnterMyName. Click Save button to save the macro and close the Basic Macros dialog box.
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Creating a Simple Macro as a Function
Perform the following steps for creating a simple macro as a function:

	 1	 Select Tools  W  Macros  W  Organize Macros  W  Basic for opening macros editor. Select Libraries 
from Organizer dialog box. Ensure the Location dropdown is set to My Macros & Dialogs.

	 2	 Click the New button, enter a library name (e.g., Library2), and click OK button. In the Modules tab, 
expand My Macros and select your library (Library2). Use the existing Module1 or create a new 
module by clicking New.

	 3	 Select the module (e.g., Module1) and click Edit to open the Integrated Development Environment 
(IDE). Insert your macro code into the module. For example:

Sub HelloMacro
    Print Hello
End Sub

Sub Main
End Sub

		  Then click on Run or press F5. Choose the HelloMacro and click on Run. 
The output is shown in Figure 21.

Passing Arguments to a Macro
Perform the following steps for passing arguments to a macro:

	 1	 Open the macro editor and enter the following code:

Function PositiveSum(Optional x)
Dim TheSum As Double
Dim iRow As Integer
Dim iCol As Integer
TheSum = 0.0
If NOT IsMissing(x) Then
If NOT IsArray(x) Then
If x > 0 Then TheSum = x
Else
For iRow = LBound(x, 1) To UBound(x, 1)
For iCol = LBound(x, 2) To UBound(x, 2)
If x(iRow, iCol) > 0 Then TheSum = TheSum + x(iRow, iCol)
Next
Next
End If
End If
PositiveSum = TheSum
End Function

	 2	 Assign the macro to a button or call it from another macro with =PositiveSum(7).   

Passing Arguments as Values
Perform the following steps for passing arguments as values:

	 1	 Open the macro editor and enter the following code:

Sub MultiplyValues(a As Double, b As Double)
Dim result As Double
result = a * b

Figure 21:  Basic Macros
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MsgBox "The result is " & result
End Sub

	 2	 Use MultiplyValues(5, 10) in the macro editor to see the result.

Accessing Cells Directly
Perform the following steps for assessing cells directly:

	 1	 Open LibreOffice Calc. Navigate to Tools W Macros W Edit Macros to open the macro editor. 

	 2	 Create a new module and enter the script for SumCellsAllSheets in the macro editor. Enter the 
following code:

Function SumCellsAllSheets()
    Dim TheSum As Double
    Dim i As Integer
    Dim oSheets
    Dim oSheet
    Dim oCell

    TheSum = 0
    oSheets = ThisComponent.getSheets()
    For i = 0 To oSheets.getCount() - 1
        oSheet = oSheets.getByIndex(i)
        oCell = oSheet.getCellByPosition(0, 1) ‘ Get cell A2
        TheSum = TheSum + oCell.getValue()
    Next i
    SumCellsAllSheets = TheSum
End Function

	 3	 Go to View  W Toolbars W Form Controls to show the form controls toolbar for assigning the Macro 
to a Button. Click the button icon and draw a button on the spreadsheet.

	 4	 Right-click the button and select Control Properties. In the Events tab, assign the Execute Action 
event to the SumCellsAllSheets macro.

	 5	 Call the Macro from another Macro by using the code:

Sub CallSumCellsAllSheets()
    Dim result As Double
    result = SumCellsAllSheets()
    MsgBox "The sum of values in cell A2 from all sheets is: " & result
End Sub

	 6	 Run the CallSumCellsAllSheets macro to ensure it 
correctly sums the values in cell A2 from all sheets and 
displays the result in a message box.

Sorting Columns Using a Macro
Perform the following steps for sorting columns using a macro:

	 1	 Open LibreOffice Calc. Enter the following data, as shown 
in Figure 22:

Figure 22:  Unsorted Columns
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	 2	 Create a new module and enter the code for SortRange in the macro editor, as shown below:

Sub SortRange
    Dim oSheet ‘ Calc sheet containing data to sort.
    Dim oCellRange ‘ Data range to sort.

    REM An array of sort fields determines the columns that are
    REM sorted. This is an array with two elements, 0 and 1.
    REM To sort on only one column, use:
    REM Dim oSortFields(0) As New com.sun.star.util.SortField
    Dim oSortFields(1) As New com.sun.star.util.SortField
    REM The sort descriptor is an array of properties.
    REM The primary property contains the sort fields.
    Dim oSortDesc(0) As New com.sun.star.beans.PropertyValue

    REM Get the sheet named "Sheet1"
    oSheet = ThisComponent.Sheets.getByName("Sheet1")

    REM Get the cell range to sort
    oCellRange = oSheet.getCellRangeByName("A1:C5")

    REM Select the range to sort.
    REM The only purpose would be to emphasize the sorted data.
    ‘ThisComponent.getCurrentController.select(oCellRange)

    REM The columns are numbered starting with 0, so
    REM column A is 0, column B is 1, etc.
    REM Sort column B (column 1) descending.
    oSortFields(0).Field = 1
    oSortFields(0).SortAscending = FALSE

    REM If column B has two cells with the same value,
    REM then use column A ascending to decide the order.
    oSortFields(1).Field = 0
    oSortFields(1).SortAscending = TRUE

    REM Setup the sort descriptor.
    oSortDesc(0).Name = "SortFields"
    oSortDesc(0).Value = oSortFields()

    REM Sort the range.
    oCellRange.Sort(oSortDesc())
End Sub

	 3	 Save your macro by clicking the save icon or using File W Save. Click the Run icon in the Macro 
toolbar of the LibreOffice Basic IDE to execute the macro. The output is shown in Figure 23:

	
	 Figure 23:  Sorted Columns Using Macros

Refer “Electronic 
Spreadsheet (Advanced)” 
on pages 155-203 in 
Information Technology 
(402) book for Class 10 for 
more.
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Database Management System
A Database Management System (DBMS) is software that enables the creation, management, and 
manipulation of databases. It provides a systematic and organized way to store, retrieve, and manage 
data in a database, ensuring that the data is easily accessible, secure, and consistently maintained. A 
DBMS abstracts the complexities of data storage, allowing users to interact with the data using queries, 
reports, and other tools without needing to understand the underlying architecture.

Key functions of a DBMS include data storage, retrieval, update, and administration. It supports various 
types of databases, such as relational, hierarchical, network, and object-oriented databases. A relational 
DBMS (RDBMS), which uses tables to represent data, is the most common type. The DBMS also enforces 
data integrity, ensuring that data is accurate and consistent, and provides tools for data backup, recovery, 
and security.

In addition to handling the physical storage of data, a DBMS manages concurrent data access, allowing 
multiple users to interact with the database simultaneously without conflicts. It also optimizes query 
performance, ensuring efficient data retrieval and manipulation.

Session 1: Creating a Database
LibreOffice Base allows you to design and manage databases with ease. You can create tables, forms, 
queries, and reports to organize and retrieve data efficiently. The process begins by defining a new 
database file and selecting the appropriate database type (e.g., embedded HSQLDB). You can then create 
tables to store your data, define relationships between them, and use forms to enter and manage the 
data. Queries allow you to extract specific information, and reports help present the data in a structured 
format. LibreOffice Base provides a user-friendly interface, making database management accessible 
even to users with limited technical knowledge.

Perform the following steps to create a database:

	 1	 Click the LibreOffice icon to open the LibreOffice Start Center on your desktop or in the Start 
menu.

		  In the LibreOffice Start 
Center, you will see various 
application icons, such as 
Writer, Calc, Impress, and 
Base, as shown in Figure 1.

	 2	 Click the Base Database icon 
from the list of available 
applications, as shown in 
Figure 1.

		  A Database Wizard dialog 
box appears, as shown in 
Figure 2.

	 3	 Select the Create a new 
database radio button 
(Figure 2).

Figure 1:  Displaying the Welcome to the LibreOffice Database
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	 4	 Click the Next button, as shown in Figure 2:

	
	 Figure 2:  Creating a New Database

		  The Decide How to Proceed After Saving the Database page appears, as shown in Figure 3.

	 5	 Select the Yes, register the database for me option (Figure 3).

	 6	 Click the Finish button, as shown in Figure 3:

	
	 Figure 3:  Deciding How to Proceed After Saving the Database

		  A Save As dialog box appears (Figure 4).

	 7	 Select the location in the Navigation pane where you want to save the database. In our case, we 
have selected Desktop (Figure 4).

	 8	 Type the name of the document in the File name combo box. In our case, we have typed My 
Database (Figure 4).

	 9	 Click the Save button (Figure 4).
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		  The desired database is saved with the specified name, as shown in Figure 4:

	
	 Figure 4:  Displaying the Saved Database on the Desktop

The OpenOffice Base window appears with the name of the newly created database, i.e., Student_
Database.odb. LibreOffice Base provides a user-friendly interface with several key components designed 
for efficient database management, as shown in Figure 5:

		

Menu bar ToolbarTitle bar Window control buttons

Task pane

Database 
object 

buttons

Status bar

	 Figure 5:  Displaying a Database in the OpenOffice Base Window

The LibreOffice Base application user interface components, shown in Figure 8, are described as follows:

  Title bar: Displays the title of the Open Office Base database.

  Window Control buttons: Allow you to minimize, maximize and close the OpenOffice Base window.

  Menu bar: Contains various menus such as File, Edit, View, Insert, Tools, Window and Help. It is 
located below the Title bar.

  Toolbar: Contains various tools for performing standard tasks such as creating a new database, 
opening an existing database and saving a database. It is located below the Menu bar.

  Database Object buttons: Allow you to create various objects of the database such as tables, 
queries, forms and reports. These buttons are located in the left pane of the OpenOffice Base 
window.
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  Tasks pane: Contains different options to create a database object on the basis of the selection of 
database object button. 

  Status bar: Shows the progress of any task being performed on the database. It is located at the 
bottom of the OpenOffice Base window.

Closing the Database and Quiting the LibreOffice Base Application
When you finish working with a database in LibreOffice Base, it’s 
important to close it properly to ensure that your data is saved and to 
prevent any potential corruption.

Perform the following steps to close a database:

	 1	 Click the File button from the Menu toolbar (Figure 6).

		  A drop-down list appears, as shown in Figure 6.

	 2	 Select the Close option from the drop-down list, as shown in 
Figure 6.

		  The current database gets closed, and the LibreOffice Base window 
appears.

In LibreOffice Base, quitting a database involves closing the application 
or ending your current database session.

Perform the following steps to quit a database:

	 1	 Click the File button from the Menu toolbar (Figure 7).

		  A drop-down list appears (Figure 7).

	 2	 Select the Exit LibreOffice option from the drop-down list, as 
shown in Figure 7.

		  The LibreOffice Base application gets closed.

Opening an Existing Database
Perform the following steps to open an existing database document:

	 1	 Click the File button from the Menu toolbar (Figure 8).

		  A drop-down list appears (Figure 8).

	 2	 Select the Open option from the drop-down list  
(Figure 8).

	 3	 Navigate to the location where your database file 
is stored. In our case, we have selected Desktop  
(Figure 8).

	 4	 Select the desired database document that you want 
to open. In our case, we have selected My Database 
(Figure 8).

	 5	 Click the Open button to load the selected database 
document, as shown in Figure 8.

Figure 6: � Close Option in LibreOffice 
Database Window

Figure 7: � Exit LibreOffice Option

Figure 8: � Selecting the Database Document Opened 
from Desktop
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		  The desired database document gets opened, as shown in Figure 9:

	
	 Figure 9:  Displaying the Opened My Database Document

Session 2: Creating a Table in Base
In LibreOffice, a table in a database is a structured format that stores data in rows and columns, allowing 
for organized and efficient data management. Each row in a table represents a record, while each column 
corresponds to a specific field within that record. The creation of a table involves defining the table’s 
structure by specifying the field names, data types, and constraints such as primary keys or unique values. 
LibreOffice’s database component, Base, offers a user-friendly interface for creating and managing tables, 
enabling users to input, query, and manipulate data effectively.

Creating Using Design View
Design View in LibreOffice Base is a methodical process that allows for precise control over the structure 
of a database table. In Design View, users can define the table’s fields, specify data types, set primary 
keys, and establish field properties. This interface provides a grid where each row represents a field in 
the table, and columns offer settings such as field name, type, and description. Design View is particularly 
useful for advanced users who need to customize how data is stored and validated. After defining the 
structure, the table is saved and can then be populated with data. This approach ensures that the database 
is tailored to the specific needs of the user, offering flexibility and precision in data management.

Perform the following steps to create a table using Design 
View:

	 1	 Open a new or existing database in which you want to 
create a table.

	 2	 Click the Tables option from the left sidebar (Figure 10).

		  Various options related to the selection are displayed in 
the Tasks pane (Figure 10).

	 3	 Select the Create Table in Design View option under the 
Tasks pane, as shown in Figure 10.

Figure 10: � Selecting the Create Table in Design 
View Option
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		  The Table Design window appears as shown in Figure 11:

	
	 Figure 11:  Displaying the Table Design Window

	 4	 Type Employee_Id in the Field Name (Figure 12).

	 5	 Press the Enter key to move to the Field Type column. In 
the Field Type column, the Text [VARCHAR] field type is 
selected by default (Figure 12).

	 6	 Click the down arrow button in the Field Type (Figure 12).

		  A drop-down list appears, as shown in (Figure 12).

	 7	 Select the Number [NUMERIC] fields type from the drop-
down list, as shown in Figure 12.

		  Similarly, you can define the various fields and their types 
in the Table Design window.

	 8	 Type Employee_Name in the Field Name (Figure 13).

	 9	 Select the Text [VARCHAR] fields type from the drop-down 
list (Figure 13).

	 10	 Type Employee_Designation in the Field Name (Figure 13).

	 11	 Select the Text [VARCHAR] fields type from the drop-down list (Figure 13).

	 12	 Type Employee_Address in the Field Name (Figure 13).

	 13	 Select the Text [VARCHAR] fields type from the drop-down list (Figure 13).

	 14	 Type Employee_Mobile.No. in the Field Name (Figure 13).

	 15	 Select the Number [NUMERIC] fields type from the drop-down list (Figure 13).

	 16	 Click the Save button from the quick access toolbar, as shown in Figure 13.

		  The Save As dialog box appears, as shown in Figure 14.

	 17	 Type the desired name for the table in the Table Name 
text box. In our case, we have typed Employee_Details 
(Figure 14).

	 18	 Click the OK button, as shown in Figure 14.

Figure 12:  Defining the First Field and Its Type

Figure 13:  Defining Fields and Their Types

Figure 14:  Displaying Save As dialog box
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		  A LibreOffice Base message box appears, as shown in 
Figure 15.

	 19	 Click the No button to create the primary key of your 
choice. If you want a primary key to be automatically 
created for the table, click the Yes button, as shown in 
Figure 15.

Creating Using Wizard
The Wizard guides users through a series of steps, making it easy for those who may not be familiar with 
database design. The Wizard offers predefined table templates for common database scenarios, such 
as managing contacts or invoices. Users can select the most appropriate template and customize it by 
adding, modifying, or deleting fields. The Wizard also allows users to define field types, set primary keys, 
and choose table relationships. Once all the necessary adjustments are made, the Wizard completes the 
table creation, and the new table is ready for data entry. This tool is particularly useful for beginners, 
as it provides a structured approach to table creation, ensuring that all essential elements are included.

Perform the following steps to create a table using Wizard:

	 1	 Open a new or existing database in which you want to create a table.

	 2	 Click the Tables option from the left sidebar (Figure 16).

		  Various options related to the selection are displayed in the Tasks pane (Figure 16).

	 3	 Select the Use Wizard to Create Table option under the Tasks pane, as shown in (Figure 16).

		  The Table Wizard window appears as shown in (Figure 16).

	 4	 Select the desired option under the Category section from the Select fields for your table page. In 
our case, we have selected Business, as shown in Figure 16:

	 5	 Click the down arrow button in the Sample tables (Figure 17).

		  A drop-down list appears, as shown in (Figure 17).

	 6	 Select the desired Sample tables from the drop-down list. In our case, we have selected Employees, 
as shown in Figure 17:

	
	 Figure 16:  Select Category for Your Table Page

Figure 17: � Select Fields for Your 
Table Page

Figure 15:  The LibreOffice Base Message Box

©Copyright 2024 by Dreamtech Press



Information Technology32

	 7	 Move the Fields from the Available Fields shelf by using (>>) buttons, and then click the Finish 
button to finish setting up table using Wizard. The window to add records in the table will open 
next.

Session 3: Operations on Table
Tables are the fundamental structures used to store data in a relational database, such as those created 
in LibreOffice Base. They consist of rows (records) and columns (fields), where each field represents a 
specific attribute of the data (e.g., name, age, salary), and each row represents a single record containing 
data values. Operations on tables in LibreOffice Base refer to the various tasks you can perform to 
manage, manipulate, and analyze your data.

Field Properties
Field properties in LibreOffice Base define the characteristics and behavior of data within a table’s 
columns. They include settings such as data type, field size, default values, validation rules, and formatting 
options. Configuring field properties ensures data integrity, accurate input, and proper data handling, 
enhancing the overall functionality and usability of the database.

Entering Records in a Table
Perform the following steps to enter records in a table:

	 1	 Open LibreOffice Base and create a database naming Demonstrations. Create a table using Design 
View and add the following fields: EmployeeID (Integer), FirstName (Text), LastName (Text), 
Department (Text), and Salary (Decimal). Make EmployeeID the primary key and save the table 
as Employee. Close the Design View. Double-click on the Employee table in Table Shelf to enter 
records. This will open the table in a spreadsheet-like view, as shown in Figure 18:

	
	 Figure 18:  Spreadsheet View for Entering Records

	 2	 Click on the first cell to the enter data. The cursor will appear in the cell. Type in the data for each 
field in the record. Press the Tab key to move to the next field, or Enter to move to the next row. 
Continue entering data for each record, moving through the fields as needed. To add a new record, 
click on the empty row at the bottom of the table. This row is usually marked with a right facing 
triangle and a plus sign  (+) on the left side. The record entered is shown in Figure 19:

	
	 Figure 19:  Entering Records  the Table
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	 3	 Click on the Save icon in the toolbar or press Ctrl + S on the keyboard to save the data.

Editing and Deleting Records in a Table
Perform the following steps for editing or deleting records in the table:

	 1	 Right-click on a cell to edit the current data and type the new data, as shown in Figure 20. Press 
Enter or Tab to save the changes and move to the next field or row.

	
	 Figure 20:  Editing Records in the Table

	 2	 Click on the row header (the grey box on the left of the row) to 
select the entire row. Right-click on the row header and select 
Delete Rows, as shown in Figure 21. Alternatively, press the 
Delete key on your keyboard. A dialog box will appear asking 
for confirmation. Click the Yes button to delete the record.

Sorting Records in a Table
Click on the Salary tab in the Table Data View. Select the Sort Ascending button 
on the toolbar, as shown in Figure 22. The Salary tab will be sorted in ascending 
order.

Relationships in Base
In LibreOffice Base, relationships are crucial for organizing and managing data 
across multiple tables. They help you maintain data integrity, avoid redundancy, 
and enable more complex queries and reports. Relationships in a database 
establish connections between tables based on common fields. They help define 
how data in one table relates to data in another. By creating relationships, you 
can enforce rules about how records in one table are associated with records in another, which is essential 
for creating a well-structured and efficient database. The types of relationships in LibreOffice Base are:

  One-to-One (1:1): Each record in Table A corresponds to exactly one record in Table B, and vice 
versa. For example, a table of Employees and a table of EmployeeDetails where each employee has 
a unique record in both tables.

  One-to-Many (1:∞): A single record in Table A can be associated with multiple records in Table B. 
For example, a Departments table and an Employees table where each department can have many 
employees, but each employee belongs to only one department.

  Many-to-Many (N:∞): Records in Table A can be associated with multiple records in Table B, and 
vice versa. This type often requires a junction table to manage the relationships. For example, a 
Students table and a Courses table where students can enroll in multiple courses, and each course 
can have multiple students.

Figure 21:  Deleting Records in the Table

Figure 22: � Sorting Salary in 
Ascending Order
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Session 4: Creating Query in LibreOffice Base
Creating a query in LibreOffice Base allows you to retrieve and manipulate data from one or more tables. 
Queries enable you to filter, sort, and summarize information according to specific criteria, providing 
customized views and reports to better analyze and understand your database data.

Creating Query in Design View
Perform the following steps for creating a query in Design View:

	 1	 Open LibreOffice Base and select Demonstration database to create the query. Click on the Queries 
icon on the left pane in the main database window.

	 2	 Click on Create Query in Design View in the Tasks section. Select any saved tables (Employee) to 
include in the query in the Add Table or Query dialog box, as shown in Figure 23 Click the Add 
button for each table, and then click the 
Close button once all necessary tables are 
added.

	 3	 Double-click on the fields to include in the 
query. These fields will appear in the lower 
part of the window. Alternatively, drag 
fields from the table boxes to the columns 
in the lower part of the window. In this 
case, the fields EmployeeID, FirstName, 
LastName, Department, and Salary are 
used.

	 4	 Enter criteria in the Criteria row for the 
corresponding field to filter the data in 
the lower part of the Query Design View. 
Here, criteria for Department IT are used, 
and for Salary <50000 are used.

	 5	 Click on the Run Query icon (a green 
checkmark) in the toolbar to see the query 
results. The output is shown in Figure 24:

		
	 Figure 24:  Query in Design View

Figure 23:  Adding Table for Query
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Creating Query with Wizard
Perform the following steps for creating a query using the Wizard:

	 1	 Click the Use Wizard to Create Query in the Tasks section. Select the Employee table from the 
Tables drop-down menu in the Query Wizard – Field Selection step, as shown in Figure 25:

	
	 Figure 25:  Field Selection Step of Creating Query with Wizard

	 2	 Move the desired fields from the Available fields list to the Fields in the Query list by selecting them 
and clicking the >> button. Click the Next button to go to the Sorting Order step. Select Employee 
Salary in the Ascending order in the first text box of Select the sorting order dialog box.

	 3	 Click the Next button to go to the Search Conditions step. Set conditions to filter the data. Choose 
the field and the condition, and enter the value to compare, as shown in Figure 26. Add multiple 
conditions if needed.

	
	 Figure 26:  Search Condition of the Query
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	 4	 Click the Next button to go to the Grouping step if data grouping is required. Select the fields to 
group by and set any aggregate 
functions (e.g., SUM, AVG). Click 
the Next button to go to the Detail 
or Summary step. Choose whether 
to create a detail query (showing 
individual records) or a summary 
query (showing grouped data with 
aggregate functions).

	 5	 Click the Next button to go to 
the Alias step. Optionally, assign 
aliases (alternate names) to the 
fields for better readability. Click 
the Next button to go to the 
Overview step. Review the choices 
made in the wizard. Click the Back 
button if any changes are needed. 
Click the Finish button to save the 
query. Enter a name for the query 
and click the OK button. The 
output is shown in Figure 27.

Handling Query with SQL Commands
Perform the following steps for handling query using SQL commands:

	 1	 Go to the Tables section in LibreOffice Base and click on Create Table in Design View. Define the 
table structure as shown below and save the table as InvoiceDetails. 

		  Enter the data provided below in the InvoiceDetails table as shown in Table 1:
	 Table 1:  InvoiceDetails Table

ID OrderID ProductID UnitPrice Quantity Discount

1 1000 989 66 2 10

2 1001 157 127 6 13

3 1002 311 200 1 10

4 1003 55 9000 8 10

5 1004 96 24 10 12

6 1005 144 15639 2 10

	 2	 Go to the Queries section and click on Create Query in SQL View. Enter your SQL query for SELECT 
command. The outputs are shown in Figures 28 and 29, respectively:

		  SQL Query 1

SELECT * FROM InvoiceDetails

Figure 27:  Query Using Wizard
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	 Figure 28:  SQL Query 1

		  SQL Query 2

SELECT ID, OrderID, ProductID, UnitPrice FROM InvoiceDetails;

	
	 Figure 29:  SQL Query 2
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Understanding Criteria in Query
In LibreOffice Base, criteria in a query are conditions used to filter records from a table. By setting 
criteria (such as specific values, ranges, or patterns), you can retrieve only the data that meets specified 
conditions within a query.

Session 5: Creating Form in LibreOffice Base
In LibreOffice Base, forms are user-friendly interfaces for entering, viewing, and editing data in your 
database tables. Creating a form simplifies data management by allowing you to interact with multiple 
fields at once. You can design a form using the Form Wizard, which guides you step-by-step in selecting 
fields, layout, and style. Alternatively, forms can be customized in Design View for advanced formatting. 
Forms are essential for enhancing the usability and functionality of your database.

Creating a Form Using Design View
Perform the following steps for creating a form using Design View:

	 1	 Open the LibreOffice Base file. In the 
main database window, click on the 
Forms section in the left pane. Click on 
Create Form in Design View.

	 2	 Left-click on Form Properties from the 
Form option in the Menu Bar. In the 
Data tab, set the Content type to Table. 
Select the table (e.g., InvoiceDetails) in 
the Content field.

	 3	 Click on Add Field from the Form 
Design Toolbar. Drag and drop the 
required field on the form. Then click 
the Design Mode option from the Form 
menu to leave the design mode. Then 
select the Data source as a Table for 
editing or deleting records. The output 
of this step is shown in Figure 30.

	 4	 After adding and configuring all 
necessary controls, save the form by 
clicking File W Save. Close the design 
view and open the form to test data entry and navigation. The output is shown in Figure 31:

	
	 Figure 31:  Inspection of the Records Added in Form

Figure 30:  Creating Form Using Design View
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Creating Form Using Wizard
Perform the following steps for creating a Form using the Wizard:

	 1	 Open the LibreOffice Base file. In the main database window, click on the Forms section in the left 
pane. Click on Use Wizard to Create Form.

	 2	 Select the table (InvoiceDetails) to use for the form in the Form Wizard. Select the fields to include 
in the form by moving them from the left pane to the right pane.

	 3	 Choose the layout for the form (e.g., columnar, tabular). Select the style for the form and set any 
other properties as needed. Name the form and click Finish button to create it. 

Session 6: Creating Report in LibreOffice Base
Creating a report in LibreOffice Base allows you to generate formatted summaries of your database data 
for analysis or presentation. The Report Wizard guides you through selecting fields, grouping, sorting, 
and defining layouts. You can also customize the design and structure. Reports provide a clear, organized 
view of data for printing or sharing.

Creating Report in Design View
Perform the following steps to create a report in the Design View:

	 1	 Open the LibreOffice Base from the applications menu. Select the Demonstration database. In the 
main database window, navigate to the Reports section.

	 2	 Click Create Report in Design View for a blank report. In the Add Field: Employee, select all the 
fields and click the Insert button in the dialog box.

	 3	 Click on Execute Report button () from the toolbar to create a report in LibreOffice. The output is 
shown in Figure 32:

	
	 Figure 32:  Output of Report Creation in Design View
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Creating Report Using Wizard
Perform the following steps to create a report using the Wizard:

	 1	 Open the LibreOffice Base and select the Demonstration database file, then click on the Reports 
section.

	 2	 Click on Use Wizard to Create 
Report to start the Report 
Wizard. Select Table: Employee 
From Table or queries shelf in 
the Report Wizard dialog box, 
as shown in Figure 36. Select 
the fields to include in the 
report by moving them from the 
Available fields list to the Fields 
in the report list using the arrow 
buttons. In this example, we use 
all the fields in the table and 
then click the Next button.

	 3	 Modify the field labels if desired 
in the Labeling field step. These 
labels will be the column headers in the report. Click the Next button and select any fields to group 
the report data by in the Grouping step. In this example, we can ignore the grouping step. Move 
the fields to the Fields to group by list if grouping is needed, and then click the Next button again.

	 4	 Set the sort order for the data in the report. In this example, we sort the data based on EmployeeID. 
Click the Next button, and then choose the layout of the report. Options include tabular, columnar, 
and more. Select the Landscape orientation and click the Next button.

	 5	 Select a type for the report by choosing between creating a static or dynamic report. In this example, 
check the Static report option and give the report a title (Employee Report). Click the Finish button 
to generate the Employee Report, as shown in Figure 34:

	
	 Figure 34:  Report Using Wizard

Refer “Database Management 
System” on pages 207-267 in 
Information Technology (402) 
book for Class 10 for more.

Figure 33:  Selecting Table: Employee
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  A word processor is a computer application that 
is used to create, edit, and organize a document. 

  LibreOffice Writer is a powerful alternative to 
other word processors like Microsoft Word, 
providing similar functionalities with support for 
various file formats.

  In LibreOffice Writer, you can create and update 
styles based on selected text to streamline 
formatting.

  Spreadsheet software like LibreOffice Calc helps 
manage large datasets efficiently, similar to an 
accountant’s ledger.

  Data analysis in LibreOffice Calc involves 
organizing, interpreting, and visualizing data using 
features such as formulas, functions, and charts.

  A hyperlink in LibreOffice Calc is a clickable link 
that navigates to a web page, another sheet, a 
specific cell, or an external document. It is useful 
for quickly accessing related resources or data 
within a spreadsheet.

  DBMS provides a systematic and organized way 
to store, retrieve, and manage data in a database, 

ensuring that the data is easily accessible, secure, 
and consistently maintained. 

  LibreOffice Base allows you to design and manage 
databases with ease. It provides a user-friendly 
interface, making database management accessible 
even to users with limited technical knowledge.

  Design View in LibreOffice Base is a methodical 
process that allows for precise control over the 
structure of a database table.

  In LibreOffice Base, relationships are crucial for 
organizing and managing data across multiple 
tables. They help you maintain data integrity, avoid 
redundancy, and enable more complex queries and 
reports. 

  In LibreOffice Base, forms are user-friendly 
interfaces for entering, viewing, and editing data 
in your database tables. Forms are essential for 
enhancing the usability and functionality of your 
database.

  Creating a report in LibreOffice Base allows you to 
generate formatted summaries of your database 
data for analysis or presentation.

�� Customize: It refers to making changes to something 
according to individual specifications.

�� Datasets: It refers to a collection of separate sets 
of information that is treated as a single unit by a 
computer.

�� Data analysis: It refers to the process of examining 
information to find something out or to aid in 
decision-making.

�� Database: It refers to a large amount of information 
that is stored in a computer system that can be read 
or changed.

�� Hyperlink: It refers to connecting another document, 
image, page, etc. on a computer document or a 
website with the help of a hyperlink.

�� Open source: Open source information or software 
can be obtained from the internet legally and for free. 
It can be used, shared, or modified.

�� Operating system: It refers to software that is 
responsible for managing the hardware and software 
resources of a computer. It also provides common 
services for computer programs. 

�� Redundancy (data): It refers to the presence of data 
that is additional to the actual data in a database or a 
data storage system.

KEY TERMS
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Solved Questions

Multiple-Choice Questions (MCQs)
	 1.	 Which toolbar in LibreOffice Writer includes icons 

for commonly used functions like Save, Undo, and 
Print?
a.	 Formatting toolbar	
b.	 Standard toolbar
c.	 Status bar	
d.	 Ruler

	 2.	 Which dialog box in LibreOffice Writer is used to 
modify image properties such as size, rotation, and 
cropping?
a.	 Format dialog box	
b.	 Edit menu
c.	 Picture settings box	
d.	 Image dialog box

	 3.	 Which menu option is used to create a What-If 
scenario?
a. 	 Format > Cells	
b. 	 Data > Scenario
c. 	 Tools > Scenario	
d. 	 View > Scenarios

	 4.	 Which menu option should you select to create a 
hyperlink in LibreOffice Calc?
a. 	 Format	
b. 	 Insert
c. 	 Data	
d. 	 Tools

	 5.	 Which component in LibreOffice Base provides quick 
access to context-sensitive tools and options?
a. 	 Sidebar	
b. 	 Status Bar
c. 	 Forms and Reports Area
d. 	 Navigation Buttons

1. b. 2. d. 3. c. 4. b. 5. a.

A N S W E R S

Very Short Answer Questions
	 1.	 How can you create a template in LibreOffice Writer?
	Ans.	 To create a template, design your database, then save it as 

a template via File > Templates > Save.

	 2.	 What is a macro in LibreOffice Spreadsheet?
	Ans.	 A macro automates repetitive tasks by running a set of 

recorded or programmed commands.

	 3.	 How can you edit an existing form in LibreOffice 
Base?

	Ans.	 Open the form in Design View and modify fields or layout 
as needed.

Short Answer Questions-I
	 1.	 What are the main style categories in LibreOffice 

Writer, and what is their purpose?
	Ans.	 LibreOffice Writer has several main style categories: 

Paragraph, Character, Page, Frame, and List styles. 
Paragraph styles control the formatting of entire 
paragraphs, including alignment and spacing. Character 
styles apply formatting to specific text within a paragraph. 
Page styles manage page layout, such as margins and 
headers. Frame styles adjust the appearance of objects like 
text boxes. List styles format bulleted and numbered lists, 
defining their appearance and indentation.

	 2.	 What is a What-If Scenario in LibreOffice Calc? 
	Ans.	 A What-If Scenario in LibreOffice Calc allows users to test 

different values for specific cells to see how changes affect 
the outcome of formulas or calculations. This feature helps 
in forecasting and decision-making by comparing various 
possible outcomes based on different inputs.

	 3.	 How does LibreOffice Base handle database 
management?

	Ans.	 LibreOffice Base is a DBMS that provides a graphical 
interface for creating, managing, and querying databases. 
It supports various database formats like HSQLDB 
and MySQL. Users can create tables, forms, queries, 
and reports, define relationships, and perform data 
manipulation through an easy-to-use interface, making it 
suitable for both simple and complex database tasks.

Short Answer Questions-II
	 1. 	 What is the purpose of the Fill Format option 

in LibreOffice Writer, and how can it be used to 
enhance document design?

	Ans. 	 The Fill Format option in LibreOffice Writer allows users 
to apply a background color or pattern to an object or text 
to enhance visual appeal and organization. This feature is 
particularly useful for creating visually distinct sections or 
highlighting important information. To use the Fill Format 
option, select the object or text you want to modify. Go 
to the "Format" menu, choose "Fill," and then select the 
desired color or pattern from the options available. You 
can adjust the Fill's transparency and gradient to achieve 
the desired effect. This option is beneficial for improving 
the readability of the document and making specific 
elements stand out.
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	 2.	 How can you edit or remove a hyperlink in a 
LibreOffice Spreadsheet?

	Ans. 	 To edit or remove a hyperlink in a LibreOffice Spreadsheet, 
right-click on the cell containing the hyperlink and select 
"Hyperlink" from the context menu. For editing, in the 
"Insert Hyperlink" dialog box, you can modify the URL or 
display text as needed. After making changes, click "Apply" 
and then "Close" to update the hyperlink. To remove the 
hyperlink, right-click the cell, choose "Hyperlink," and then 
click "Remove Link" in the dialog box that appears. This 
action will delete the hyperlink while keeping the text in 
the cell intact.

	 3.	 How can you customize the layout of a report in 
LibreOffice Base?

	Ans. 	 To customize the layout of a report in LibreOffice Base, 
use the "Design View" of the report. In this view, you can 
modify the arrangement of fields by dragging and resizing 
them. To adjust the appearance, utilize the properties 
pane to change fonts, colors, and alignments. Add headers, 
footers, and page numbers by inserting the corresponding 
elements from the design toolbar. For more advanced 
customizations, you can use the "Report Wizard" to set 
specific parameters and group data. Save your changes 
frequently to preserve your customized layout.

Long Answer Questions
	 1. 	 What is a Table of Contents in LibreOffice Writer, and 

why is it important for document organization?
	Ans.	 A Table of Contents (ToC) in LibreOffice Writer is a 

structured list that outlines the headings and subheadings 
within a document, along with their corresponding page 
numbers. It serves as a navigational tool, enabling readers 
to quickly locate specific sections of the document. To 
create a ToC, LibreOffice Writer automatically generates 
it based on the document's heading styles, such as 
Heading 1, Heading 2, and Heading 3. This ensures that 
as the document evolves, the ToC can be updated easily 
to reflect changes in the content's structure. The ToC is 
essential for large or complex documents, such as reports, 
theses, or books, as it enhances readability and provides 
a clear overview of the document's organization. It helps 
both authors and readers by summarizing the content and 
improving navigation, which is particularly useful when 
dealing with extensive information.

	 2. 	 How can Goal Seek be applied to financial 
forecasting in LibreOffice Spreadsheet?

	Ans.	 In financial forecasting, Goal Seek in LibreOffice 
Spreadsheet can be invaluable for determining the required 
inputs to meet specific financial targets. For instance, 
suppose you are preparing a financial model to forecast 
the future value of an investment based on variable 
interest rates. You might have a formula calculating the 
future value of an investment based on the initial amount, 
interest rate, and time period. If you want to determine 
what interest rate is needed to achieve a target future 
value, you can use Goal Seek. First, ensure your formula 
is correctly set up in your spreadsheet. Then, navigate to 
Tools > Goal Seek and enter the following details: set the 
target cell to the cell containing the future value formula, 

specify the target value you want to achieve, and indicate 
the cell that represents the interest rate. Goal Seek will 
then adjust the interest rate until the future value matches 
your target. This method allows for precise financial 
planning and scenario analysis by automatically solving for 
unknown variables that will help achieve desired financial 
outcomes.

	 3. 	 How can relationships between tables be established 
in LibreOffice Base, and why are they important for 
database management?

	Ans.	 In LibreOffice Base, relationships between tables 
are established through the Relationships window, 
accessible via the Database menu. Users can create 
these relationships by dragging and dropping fields 
from one table to another. Typically, a primary key from 
one table is linked to a foreign key in another, ensuring 
data integrity and consistency. This relational structure 
allows for efficient data retrieval and manipulation by 
maintaining logical connections between related data sets. 
Relationships are crucial because they enforce referential 
integrity, preventing orphaned records and reducing data 
redundancy. They also facilitate complex queries and 
reporting, enabling users to extract meaningful insights 
from interconnected data.

Higher Order Thinking Skills (HOTS) Question
	 1.	 Alex's document is outdated and needs to be 

updated according to a newly revised template. How 
can this be done?

	Ans.	 Alex should first open the document and then select 
"Styles" from the sidebar. By choosing "Load Style from 
Template," Alex can apply the latest template styles to the 
document, ensuring that it is consistent with the updated 
template guidelines.

	 2.	 An employee is preparing a financial forecast and 
needs to analyze different revenue scenarios. How 
can LibreOffice Calc’s What-If tools help? 

	Ans.	 Use the “Data Tables” feature to create a table with 
varying revenue inputs and observe how changes affect 
the forecasted results. This tool allows you to test multiple 
scenarios quickly and efficiently.

	 3.	 A manager requests a detailed report of customer 
orders with their contact information and order 
dates. What steps would you take to produce this 
report? 

	Ans.	 Create a new report using the Report Wizard, join 
the customer and orders tables, and include fields for 
customer details and order dates. Adjust the report layout 
for clarity and completeness.

Assignment

Multiple-Choice Questions (MCQs)
	 1.	 Which document types can be created using 

LibreOffice Writer?
a.	 Spreadsheets and presentations
b.	 Reports and personal letters

©Copyright 2024 by Dreamtech Press



Information Technology44

c.	 Database tables and queries
d.	 Graphs and charts

	 2.	 Which feature of LibreOffice Calc helps with 
automating repetitive tasks?
a.	 Macros
b.	 Queries
c.	 Slide transitions
d.	 Forms

	 3.	 What does LibreOffice Base provide to make 
database management accessible to users with 
limited technical knowledge?
a.	 Advanced coding tools
b.	 User-friendly interface
c.	 Complex query language
d.	 Automatic data entry

Very Short Answer Questions
	 1.	 What is LibreOffice Writer?

	 2.	 How do you start a new spreadsheet in LibreOffice 
Calc?

	 3.	 What is the primary function of a Database 
Management System (DBMS)?

Short Answer Questions-I
	 1.	 What is a paragraph style, and how does it differ 

from a character style?

	 2.	 What is the purpose of consolidating data in 
LibreOffice Calc?

	 3.	 What is the first step in creating a new database in 
LibreOffice Base?

Short Answer Questions-II
	 1.	 What steps are involved in modifying, resizing, 

cropping, and deleting an image in LibreOffice 
Writer?

	 2.	 What is the primary function of the Goal Seek tool in 
LibreOffice Calc?

	 3.	 What is the purpose of a table in a LibreOffice Base 
database?

Long Answer Questions
	 1.	 Describe the process for applying a style to text 

using the Fill Format option in LibreOffice Writer, 
including how to access the Styles and Formatting 
window.

	 2.	 After combining data from Sheet1, Sheet2, and 
Sheet3 into Sheet1, how would you use the Subtotals 
feature to calculate the total salary expense for each 
department? Describe the specific steps and options 
you would select to achieve this.

	 3.	 Describe how to create a new table using the Wizard 
in a database application.
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